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Emulation 
T27 eXpress Plus Screen 

A T27 eXpress Plus window contains all the necessary Windows controls to manage a host connection.  
Controls are available to control the size of the font displayed and the spacing between lines.  There are 
also controls to perform print functions, recall previously entered input, execute user-developed scripts, 
etc. 

When multiple screens are open, you may use the Esc key to switch between non-minimized screens.  
Likewise, the Next Window selection from the Window menu will switch between non-minimized 
screens. 

The following is an explanation of each menu selection or control.  When shortcut keys are available, the 
key combination (e.g., Ctrl+L) is shown to the right of the menu selection. 

File menu 

The File menu contains controls to configure the appearance and behavior of T27 eXpress Plus and to 
manage the print environment of T27 eXpress Plus. 

Print Screen (text only) 
Use this selection to print only the text portion of the screen without delimiters. 

Note: For passthrough printing, run the T27 eXpress Plus Passthrough Print Manager program. 

Print Screen (with delimiters)   Ctrl+P 
Use this selection to print an exact image of the entire screen, including delimiters. 

Print Unprotected 
Use this selection to print only the unprotected text on the screen. 

Print Capture 
Use this toggle in conjunction with the Print commands to capture screen images and save them 
to a text file.  When this selection is checked, the Select Print Text File dialog appears allowing 
you to select a text file in which to save the images.  Next, use one of the Print commands to 
write the screen image to the file.  Multiple screens may be saved by using multiple Print 
commands.  To close the text file, select Print Capture again. 

Print Window Image 
Use this selection to print the entire window including the screen and the Windows controls 
surrounding the screen. 

Printer Setup... 
Use this selection to select a printer for use in future print operations. 

Capture Screen   Alt+Shift+Backspace 
Use this selection to capture the currently selected screen. 

Print Captured Screens 
Use this selection to print any captured screens. 

Save Captured Screens 
Use this selection to save any captured screens to a text file. 

Clear Captured Screens 
Use this selection to clear the captured screen stack. 

Send To… 
Use this button to send a copy of the screen through your mail system. 

Diagnostics 

Trace to Window 
Use this selection to initiate the T27 eXpress Plus trace facility.  All communications 
between T27 eXpress Plus and the host will be displayed in a separate window. 

Note:  A right mouse click in the trace window will reveal a menu containing three 
selections that control the trace window: Stay on Top, Copy to Clipboard and Clear.  
Stay on Top controls whether the trace window remains on top (the default) of the 
emulator window during the trace, or remains in the background.  Copy to Clipboard 

KMSYS Worldwide, Inc. 1 



Emulation T27 eXpress Plus Help 

may be used to copy the contents of the trace window to the Windows clipboard for 
subsequent pasting into another Windows application (e.g., Notepad, Word, etc.).  Clear 
may be used to clear the contents of the trace window. 

Trace to File 
Use this selection to initiate the T27 eXpress Plus trace facility.  This selection is the 
same as Trace to Window except that the trace information will be written to a user-
named file. 

Trace to Both Window and File 
Use this selection to initiate the T27 eXpress Plus trace facility.  This selection is a 
combination of the two above. 

Clear Trace Window 
Use this selection to clear the trace window and/or file without terminating the trace.  
This selection appears after a trace has been initiated. 

Close Trace 
Use this selection to close the trace window and/or file and terminate the trace. 

FCC Map 
Use this selection to display an FCC Map.  Use only at the request of KMSYS Worldwide’s 
support personnel. 

Control Page 
Use this selection to display the contents of the UTS Control Page in the trace window 
and/or file. 

Note:  The last four selections only become visible once the trace has been started. 

Customize 
Use this selection to customize the appearance and functionality of this screen.  Note: All of these 
settings may also be changed from the configuration program. 

Custom Keyboard Layout 
Use this selection to modify a keyboard configuration.  The initial configuration shown 
will be for the keyboard assigned to this screen. 

Select Keyboard Layout 
Use this selection to assign a preconfigured keyboard to this screen. 

Custom Tool Bar Designer 
Use this selection to modify a tool bar configuration.  The initial configuration shown will 
be for a tool bar with one unassigned button.  A default tool bar is available from the File 
menu of the Custom Tool Bar Designer window. 

Select Custom Tool Bar 
Use this selection to assign a preconfigured tool bar to this screen. 

Screen Appearance 
Use this selection to modify a screen appearance scheme.  The initial configuration 
shown will be for the scheme assigned to this screen. 

Select Screen Appearance 
Use this selection to assign a preconfigured screen appearance to this screen. 

Close 
Use this selection to break the host connection and terminate this T27 eXpress Plus window. 

Edit menu 

The Edit menu contains controls to manage selected text between the screen and the Windows clipboard. 

Copy   Ctrl+C 
Use this selection to copy selected data onto the clipboard.  This command is unavailable if there 
is no data currently selected.  Note: Copying data to the clipboard replaces the contents 
previously stored there. 

Data may be selected by placing the mouse cursor at some point on the screen, and holding 
down the left mouse button, drag the mouse cursor to any other location on the screen.  Upon 
releasing the left mouse button, the data will be selected. 
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An alternate form of selection is with standard, keyboard key sequences.  With the mouse or 
arrow keys, place the screen text cursor at some point on the screen and use any of the following 
key sequences to highlight the data being selected: 

Shift+Home selects everything from the cursor position through column one of the 
same row. 

Shift+End selects everything from the cursor position through the last column of the 
same row. 

Shift+Right Arrow extends/contracts the selection to the right. 

Shift+Down Arrow extends/contracts the selection down the screen. 

Shift+Left Arrow extends/contracts the selection to the left. 

Shift+UP Arrow extends/contracts the selection up the screen. 

Cut   Ctrl+X 
Use this selection to remove the currently selected data from the document and put it on the 
clipboard.  This command is unavailable if there is no data currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 

Paste   Ctrl+V 
Use this selection to insert a copy of the clipboard contents at the insertion point.  This command 
is unavailable if the clipboard is empty. 

Note:  Use a right mouse click anywhere on the screen to reveal a Copy/Cut/Paste popup menu. 

Input Recall   Ctrl+I 
Use this selection to initiate the Input Recall window.  This selection allows previous lines 
transmitted to the host to be recalled and retransmitted. 

Rectangle Block Selection 
This option allows the selection of text as a rectangle.  When the left mouse button is held down 
and the mouse cursor dragged diagonally across the screen, a rectangular block of text is 
selected. 

Linear Block Selection 
This option allows the selection of text as a block of lines.  When the left mouse cursor is held 
down and the mouse cursor is dragged up or down, each line that the mouse cursor passes 
through will be selected. 

View menu 

The View menu contains controls that adjust the appearance and functional state of T27 eXpress Plus. 

Show Toolbar 
Use this selection to toggle the display of a T27 eXpress Plus toolbar. 

Custom Tool Bar Position 
Use this option to place the tool bar at the top or bottom of the window. 

Tool Bar at Top 
Make this selection to place the tool bar immediately above the screen area.  Note: 
Show Custom Tool Bar must be checked for this option to work. 

Tool Bar at Bottom 
Make this selection to place the tool bar immediately below the screen area.  Note: 
Show Custom Tool Bar must be checked for this option to work. 

Keyboard Window...   Alt+K 
Use this selection to display the T27 eXpress Plus Keyboard Definition window. 

Show Mouse Tracking 
Use this selection to toggle between displaying the mouse pointer's row and column and the text 
cursor's row and column.  The display appears on the left side of the status bar at the bottom of 
the screen.  This feature allows the user to determine row and column coordinates of protected 
fields, which can be handy for scriptwriters. 

Show Reference Grid 
Use this selection to toggle the display of a reference grid over the screen.  The grid is useful 
when developing scripts.  The reference grid makes it easy to find column/row coordinates while 
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a script dialog is displayed.  You cannot use mouse tracking once a script dialog is up, but you 
can see and count lines and columns on the reference grid. 

Show Control Characters 
Use this selection to toggle the display of control characters (Tab, Form-Feed, Line-Feed, etc.). 

Scripts menu 

The Scripts menu contains user-developed scripts and one entry to link a previously developed sign-on 
script to the screen. 

User-defined Script Name 
Use the Script Manager button on the T27 eXpress Plus Control Panel to develop and maintain 
Enable Scripts and the Scripts menu. 

Select Sign-On Script 
Use this selection to initiate the Select Sign-On Script for Screen window and link a previously 
developed script to the currently selected screen.  The next time the screen is opened, the linked 
script will be automatically executed. 

Select Run-Script Menu 
Use this selection to assign a menu to this screen.  Use the Script Manager selection to design 
and maintain scripts and script menus. 

Script Manager 
Use this selection to open the Script Manager dialog.  Use the Script Manager to create and 
maintain scripts and script menus. 

Record Script 
Choose this selection to start recording activities in the currently selected screen.  Note:  When 
the recorder starts, this menu item changes to End Recording Script. 

Window menu 

The Window menu contains a selection controlling the T27 eXpress Plus window size in relationship to the 
font size. 

Resize Window to Font 
Use this selection to resize the T27 eXpress Plus window to conform to the selected font size. 

Hide Control Panel/Show Control Panel 
This toggle hides or displays the T27 eXpress Plus Control Panel.  Note: If all screens are closed 
while the Control Panel is hidden, the Control Panel will be automatically displayed.  This menu 
item is disabled if the NCP (No Control Panel) command line parameter is used. 

Next Window   Crtl+Page Down 

Use this selection to switch between non-minimized screens. 

Help menu 

The Help menu contains selections that provide complete on-line help and T27 keyboard assistance. 

Contents 
Use this selection to run Windows Help for T27 eXpress Plus and display the Contents topic.  All 
on-line help may be reached from this topic. 

This Window 
Use this selection to run Windows Help for T27 eXpress Plus and display this topic. 

About 
Use this selection to display version and copyright  about T27 eXpress Plus.  

Input Recall window 

T27 eXpress Plus, when in non-forms mode, saves single-line messages sent to the host system when you 
press the transmit key.  A maximum of 200 of the most recent messages is saved.  You can display a list 
of these messages from the Edit, Input Recall menu selection, or by pressing the Input Recall key 
(Ctrl+I). 

Paste 
When this list is displayed in the Input Recall window, you can view the entries and optionally 
select an entry to be "pasted" onto the current screen when the Paste button is pressed. 
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Transmit 
The Transmit button performs the same operation as the Paste button, but also ends by 
transmitting to the host (double clicking on the entry also performs the paste-and-transmit 
operation). 

Close  
Use this button to close the Input Recall window. 

 T27 eXpress Plus Keyboard Definition window 

This window displays all the standard T27 keys and their corresponding keyboard keystrokes.  Any T27 
key may be issued by double-clicking the left mouse button over the T27 key name. Additionally, the 
window may remain open as a visual reference when entering T27 key sequences from the keyboard. 

Stay on Top 
Check this box to force the window to remain visible while working on an emulator screen. 

Keep Active on Show 
Check this box to keep focus on the T27 eXpress Plus Keyboard Definition window when the 
window first comes up.  When not checked, focus will immediately return to the main emulator 
window. 

Close 
Use this button to close the T27 eXpress Plus Keyboard Definition window. 

Send To ... 

Use this dialog to select the Send option desired. 

Send Contents of Screen as Text 

Set this option to capture the contents of the screen as text.  When the OK button is pressed, the text will 
appear in the message portion of the compose dialog displayed by your mail system. 

Send Screen Window as JPEG Attachment 

Set this option to capture the contents of the screen as a JPEG image.  When the OK button is pressed, 
the image will be inserted as an attachment to your mail message. 
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Configuration 
T27 eXpress Plus Configuration 

The T27 eXpress Plus Configuration dialog contains configuration options that assign the 
communication route to be used when the screen is opened.  It is also used to set general T27 options for 
the screen.  Each screen may also have its own tool bar, appearance scheme, keyboard and script menu 
assigned.  In addition, a sign-on script may be assigned to each screen to facilitate connecting to the host. 

Environment tabs (Env. 1 – Env. n) 

Select the environment tab you wish to configure.  The number of environment tabs shown depends on 
the number set on the Globals tab. 

 

  

Connection tab 

This tab contains controls that may be used to assign a configured route to an environment. 

Select Connection Route 
This drop-down list box contains the names of all configured routes.  To assign a route to an 
environment, select one from this list.  Once a route is assigned, its corresponding numbered 
button will be enabled on the T27 eXpress Plus Control Panel . 

Configure 
Click this button to configure the routes and virtual destinations required to connect to a host 
(Note: Each screen in use should have its own configured route).  When complete, use the 
Connection Route drop-down list box to link a newly configured route to the selected screen. 

Open This Environment on Start 
Check this box to automatically connect to the route when T27 eXpress Plus is first started. 

Trace on Start Options 
The controls in this group determine what trace activity is to take place, if any, when the screen 
is first opened. 
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None 
When this option is set, no tracing activity will take place. 

To Window 
When this option is chosen, a separate trace window will open to display the trace. 

To File 
This option will cause the Emulator TraceFile dialog to open when the screen is 
opened.  In this dialog, enter the text file name for the trace file.  The trace file is 
normally stored in C:\Documents and Settings\<username>\Local Settings\Temp 
directory and will have a .txt extension. 

To Both 
Select this option to trace to a window and file. 

 

  

Video Options tab 

The options on this tab govern the state of the monitor display.  Multiple options may be selected. 

Blinking Cursor 
Checking this box causes the current cursor position to blink.  If this box is not ch the cursor 
remains solid. 

Real Blink 
Check this box to cause data fields having the blinking attribute to blink on and off. 

If the Real Blink option is not used, blinking text will appear in the colors as configured for the 
Blinking option.  The Blinking may be set on the eXpress Custom Terminal Screen Appearance 
dialog. 

Visible Delimiters 
Check this box to display field delimiters when in forms mode (see Toggle Forms, below). 
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Auto-save Pages 
When this box is checked, the contents of all pages in an environment are saved to disk when the 
environment is closed.  The pages are then restored when the environment is re-opened.  Note: 
As a result of this action, page one will be overwritten on start up. 

 

  

DataComm Options tab 

The options on this tab govern communications between the host and PC.  Multiple options may be 
selected. 

Transmit Full Page in Forms Mode 
Check this box to cause the full page to be transmitted to the host when in forms mode (see 
Toggle Forms, below).  If this box is not checked, only the unprotected data from the home 
position to the cursor will be transmitted. 

Convert CR to CRLF 
Check this box to cause a line feed character to be appended to any carriage return character 
sent by the host application. 

Convert LF to LFCR 
Check this box to cause a carriage return character to be appended to any line feed character 
sent by the host application. 

SOH Clears Screen 
Check this box to cause the screen to be cleared upon receipt of an SOH character. 

SOH Clears Forms Mode 
Check this box to cause forms mode to be terminated upon receipt of an SOH character. 

Position to Left of UPF 
When this option is checked, the effect of the Home function places the text cursor to the first 
character position of a right justified, unprotected field; otherwise, the cursor will be moved to 
the data entry position, or rightmost position of the field. 
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Start All Pages in Forms Mode 
Check this box to set all pages initially to Forms mode.  See also, Transmit Full Page in Forms 
Mode, above, and Toggle Forms, below. 

Transmit Line at a Time 
Check this box to force the normal Transmit to act like the Transmit Line key. 

Hold in RCV Mode 
Check this box to cause the screens to remain in receive mode after getting a message from the 
host application (see Stay in RCV, below). 

Beep Alarm Sound 
Checking this box turns audible beep on.  If this box is not checked, no audible sound will be 
heard. 

SO/SI Translation 
Check this box to enable SO/SI (7-bit to 8-bit/8-bit to 7-bit) character translation on data 
transmitted to the host. 

SO/SI Extended Characters 
Check this box to enable SO/SI (7-bit-to-8-bit/8-bit-to-7-bit) character translation on data 
received from the host.  This option is not required if the host transmission is prefixed by ESC SO 
sequences. 

DC1 Function 
The mutually exclusively options in this group instruct T27 eXpress Plus how to interpret the DC1 
character when received from the host. 

Stay in RCV 
Choose this option to keep the screens in receive mode upon receipt of a DC1 character.  
This option nullifies the Hold in RCV option (see above). 

Line Clear 
Choose this option to clear the line upon receipt of the DC1 character. 

DC2 Function 
The option buttons in this group instruct T27 eXpress Plus how to interpret the DC2 character 
when received from the host. 

Toggle Forms 
Choose this option to toggle to/from forms mode upon receipt of the DC2 character. 

Advance Page 
Choose this option to stay in the current mode (forms or no-forms) and advance the 
DataComm pointer one position to the right upon receipt of the DC2 character. 

Alternate Delimiters 
In this group, enter the alternate delimiters sent by the host application.  Use of alternate 
delimiters only applies when in forms mode. 

Left Character (hex) 
In this text box, enter the hex character sent and interpreted as the beginning delimiter 
of left-justified unprotected fields.  The default is the US character (1F). 

Right Character (hex) 
In this text box, enter the hex character sent and interpreted as the ending field 
delimiter.  The default is the RS character (1E). 
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Keyboard Options tab 

The options on this tab govern keyboard actions.  Multiple options may be selected. 

Start in UPPERCASE Mode 
Check this box to convert lowercase characters that are typed to their uppercase equivalents 
when the environment if first opened.  This option may be overridden with the 
Shift+<alphakey>, Ctrl+U (upper only off) and Shift+Ctrl+U (upper only on). 

Force UPPERCASE Only 
Check this box to convert lowercase characters that are typed to their uppercase equivalents.  
This option may not be overridden by keystrokes or the host program. 

Add LF to Return 
Check this box to cause a line feed character to be appended when the Carriage Return key 
(Enter) is issued.  If this box is not checked, only the carriage return is issued. 

Automatic Field Advance 
Check this box to advance the cursor automatically to the next field when the current field 
becomes full. 

Right Justified is Numeric-Only 
If this box is checked, only the characters 0-9, space, period (.) and comma (,) will be allowed in 
a right-justified field.  If the box is not checked, any character will be accepted. 

Insert Space in Insert Mode 
Check this box to cause a space to be inserted whenever the Insert key is struck. 

Specify Sends Page Number 
Check this box to cause the page number (in addition to the normal column and row designating 
the cursor position) to be sent the host application when the Specify key is pressed. 

Specify Sends Hex 
Check the box to cause the cursor position (column and row) to be sent in hexadecimal when the 
Specify key is pressed.  When this box is not checked, the cursor position is reported in ASCII. 
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Destructive Backspace Key 
Check this box to erase characters as the Backspace key is struck. 

Ignore Programmed Macros 
When checked, this box will cause the emulator to ignore any host or manually programmed T27 
macro keys.  Checking this box does not prevent Enable scripts related to action keys from 
running.  The box is checked by default. 

CR acts like TAB 
Check this box to make the Carriage Return key (Enter ) behave like the Tab key. 

Tab Stops 
In this text box, enter the column positions (separated by commas) of the tab stops.  The default 
is 1,9,17,25,33,41,49,57. 

Character Translation Table 
From this drop-down list box, select a country that most closely matches your keyboard 
requirements. 

Clear Function 
The mutually exclusively option in this group specifies what action occurs when the Clear key is 
pressed. 

Clear Entire Screen 
Select this option to clear the entire screen. 

Clear Fields Only 
Select this option to clear all unprotected fields. 

Edit Translation Tables 
Click this button to exit the keyboard character translation tables. 

 

  

Script and Actions tab 

The controls on this tab govern the use of scripts, script menus, sign-on scripts and mouse click actions. 
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Select Automatic Sign-on Script 
Use the Select button to initiate the Select Sign-On Script for Screen window and link a 
previously developed script to the currently selected screen.  The next time the screen is opened, 
the linked script will be automatically executed.  Sign-on scripts can be developed easily using 
the T27 eXpress Plus Script Recorder found on the Script menu of any open screen (see Start 
Script Recorder and End Script Recorder). 

Select Run-Script Menu 
Use the Select button to initiate the Select Screen Script Menu window and link a previously 
created script menu to the currently selected screen.  Script menus are developed by clicking the 
Script Manager button on this tab. 

Script Manager 
Use this selection to open the Script Manager dialog.  Use the Script Manager to create and 
maintain scripts and script menus. 

Content Sensitive Scripts 
Click this button to setup a list of scripts that are to be run depending upon text received from 
host applications. 

Screen Double-Click Action 
Select an option button from this group to define the action to be taken when you double click 
the mouse button on the emulator screen.  The None option places the text cursor where the 
mouse cursor was double clicked.  Transmit places the text cursor where the mouse cursor was 
double-clicked, but also transmits all information from the cursor position back to the previous 
SOE.  The Run Script option will cause the assigned script to be executed upon a double click 
(see below).  If no script is assigned, this option acts like the None option.  Note: When setting 
the Run Script option, the screen must be closed and reopened for the action to take effect. 

Select Double-Click Script 
Use the Select button to initiate the Select Double-Click Script for Screen window and link a 
previously developed script to a double-click mouse action on this screen.  On the Select 
Double-Click Script for Screen window, highlight the desired script with a mouse click or down 
arrow and press the Select button.  This script will only be executed if the Run Script option 
button is set in the Double-Click Action group (see above). 

Screen Right-Click Action 
Select an option button from this group to define the action to be taken when you right click the 
mouse button on the emulator screen.  The None option disables any right mouse click action.  
Menu (the default) presents a popup menu of common selections.  The Run Script option will 
cause the assigned script to be executed upon a right mouse click (see below).  If no script is 
assigned, this option acts like the None option.  Note: When setting the Run Script option, the 
screen must be closed and reopened for the action to take effect. 

Select Right-Click Script 
Use the Select button to initiate the Select Right Click Script for Screen window and link a 
previously developed script to a right-click mouse action on this screen.  On the Select Right 
Click Script for Screen window, highlight the desired script with a mouse click or down arrow 
and press the Select button.  This script will only be executed if the Run Script option button is 
set in the Right Click Action group (see above). 
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Appearance and Keyboard tab 

The controls on this tab may be used to customize the screen's appearance (color, font, scaling, etc.); 
configure keys and assign keyboards; and design and assign tool bars. 

Select Screen Appearance Scheme 
From this list, select a previously configured (see Custom Appearance, below) appearance 
scheme to be applied to this screen.  Note: This selection only affects the appearance of the 
screen portion of the screen window.  To alter the appearance of the entire T27 eXpress Plus 
application, use the Application Scheme button at the bottom of the eXpress Plus Configuration 
window (see below). 

Custom Appearance 
Click this button to open the Custom Terminal Screen Appearance  window and configure an 
appearance scheme that may be applied to one or more screens. 

Select Custom Keyboard Layout 
From this list, select a previously configured (see Custom Keyboards, below) keyboard layout 
to be assigned to this screen. 

Custom Keyboards 
Click this button to open the Custom Keyboard Layouts window and configure a keyboard layout 
that may be assigned to one or more screens. 

Select Custom Tool Bar 
Use the Select button to initiate the Select Tool Bar for Screen window and link a previously 
developed tool bar to the currently selected screen. 

Custom Tool Bars 
Click this button to open the Custom Tool Bar Design window and configure tool bars that may be 
assigned to one or more screens.  Buttons may be assigned to any UTS keystroke or previously 
developed eXpress Plus script. 

Show Tool Bar 
Check this box to show the tool bar initially when the screen is first opened. 
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Restriction Settings/Configure Settings 

Click this button to toggle to and from the restriction settings dialog. 

Restriction Settings dialog 

The restriction settings dialog on the T27 eXpress Plus Configuration window contains configuration 
controls that may be used to enforce configuration security by assigning a configuration password. 

Note: This dialog is not available if you are running the network version of T27 eXpress Plus, T27 eXpress 
Net; however, the person responsible for maintaining T27 eXpress Net may grant configuration privileges 
through the T27 eXpress Net Administrator program. 

Once the password is assigned, all or selected configuration options may be disabled by checking the 
appropriate option.  Subsequently, to enable an option, you must first unlock the configuration by 
providing the assigned password. 

 

  

Use Configuration Lock Options 

Check this box to initiate password protection on configuration options.  Checking this box will cause the 
Lock Config Initial Password dialog to be displayed.  After entering and confirming the new password, 
additional security features will become visible (see below). 

Note: For the configuration lock to take effect, both the configuration and the emulator must be exited 
and restarted. 
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With this level of eXpress, users may be restricted to one of three levels: the Power User, the Limited User 
and the Restricted User. 

A Power User may configure all options including connections to the host, thus a Power User has no 
configuration restrictions.  The Power User of the network version (eXpress Net) will execute from a 
network server (file or web) as a registered user, but all configuring will be performed by the Power User 
... not the network administrator. 

A Limited User is only limited to configuring non-communications options.  The Limited User of eXpress 
Net will also execute from the server and receive all screen connections from the server (configured by the 
network administrator); however, the Limited User will be unrestricted in every other way. 

A Restricted User may be denied any configuration capabilities or limited to only those involving 
application/screen appearance and keyboards.  The eXpress Net Restricted User will execute from and 
receive all configuration information from the server.  Some parts of their configuration may optionally be 
overridden by the network administrator. 

eXpress User Capabilities at a Glance 

Allowed Capabilities  
User Level 

Configure 
Connections 

Terminal 
Settings 

Script 
Development 

Screen 
Appearance 

Customize 
Keyboards 

Application 
Scheme 

Power 
User 

Yes Yes Yes Yes Yes Yes 

Limited 
User 

No Yes Yes Yes Yes Yes 

Restricted 
User 

No No No Optional Optional Optional 

Settings Location 

The purpose of this feature is to allow all users of a single machine (Windows system) to use the same 
configuration settings for the T27 eXpress Plus terminal emulator and/or the eXpress Connect host 
connections.  By default, all emulator settings are saved in files for the current user (C:\Documents and 
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Settings\<<USER>>\Application Data\KMSystems\T27_EXPRESS_PLUS32_4.0\CONFIGURATION) which 
allows multiple users on the same machine to have their own individual settings.   

In some cases, it may be desirable to have one set of configuration settings used by all users of the 
machine.  One reason for common settings is so that the configuration settings can be done once for all 
users, instead of for each individual user; however, users should NOT be allowed to make configuration 
changes once they are set.  There should only be one allowed to maintain the configuration.  If common 
configuration settings are desired, the emulator settings will be stored in common files (C:\Documents 
and Settings\All Users\Application Data\KMSystems\T27_EXPRESS_PLUS32_4.0\CONFIGURATION) and 
removed from current user. 

The mechanism for creating common configuration settings in the T27 eXpress Plus terminal emulator is 
accessed from this dialog of the T27 eXpress Plus Configuration window.  The eXpress Connect 
transport settings are accessed from the Edit menu in the eXpress Connect Visual Configuration 
window.  Both the emulator and eXpress Connect transport settings are made common or by users, 
independent of one another.  For example, eXpress Connect transport settings may be made common, 
while emulator settings remain by user. 

The Settings Location feature is only available when Use configuration lock options is checked.  
Again, individual users should NOT be allowed to changes settings when the configuration settings are 
common to all users of the same machine.  

Restricted User Options 

The following options are only available when configuring restricted users.  Power users and limited user 
have these capabilities by default. 

Allow Customized Keyboard(s) 
Check this box to allow the restricted use to develop and use personalized keyboards. 

Allow Customized Appearance Scheme(s) 
Check this box to allow the restricted user to develop and assign appearance schemes to screens. 

Allow Customize Application Scheme(s) 
Check this box to allow the restricted user to develop and maintain appearance schemes for the 
eXpress Plus application. 
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Unlock Configuration 

This button may be used to display the Unlock Config Password dialog where the proper password may 
be entered to enable the controls on the restrictions dialog.  This button is only visible if the Use 
Configuration Lock Options check box has been set and a password entered. 

Apply 

Click this button to apply the settings immediately without exiting the configuration window.  If you have 
entered the configuration window from the emulator, you will see any changes take effect in the emulator 
immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

eXpress Plus Script Manager 

This dialog is used to manage T27 eXpress Plus Scripts. You may manually create new scripts, edit scripts 
that were previously created from scratch or with the Script Recorder, or delete obsolete/unwanted 
scripts. 

Also, scripts may be assigned Action Keys (keys used to execute the script), placed as selections on the 
screens’ Scripts menu. 

 

  

Available Script Files 

This group contains controls that may be used to create and maintain scripts.  The list box (initially blank) 
contains the available script files being maintained in the current directory.  To change the current 
directory and view/edit other scripts, press the Change Script Filder button (see below). 

New Script 
Press this button to initiate the T27 eXpress Plus Script Editor dialog and create a new script from 
scratch. 

Edit Script 
Click this button to start the T27 eXpress Plus Script Editor and edit the selected script in the 
Available Script Files list box. 

18 KMSYS Worldwide, Inc. 



T27 eXpress Plus Help Configuration 

Delete Script 
Click this button to delete the selected script in the Available Script Files list box. 

Script Menu Entries 

This group contains controls that may be used to create and maintain menus and menu items linked to 
T27 eXpress Plus Scripts.  The association of the Script Files to the Script Menu Entries is maintained in 
the Script Control File.  If a Script Control File is imported (see Import, below) and contains references to 
Script Files that are not in the current script directory, the script name in the Script Menu Entry list box 
will appear with strikethrough characters through the name.  For these scripts to function, the scripts 
must be moved to the current script directory or the directory changed with the Script Directory button. 

Script Menus 
From the drop-down list box, select a configured menu.  The default menu from KMSYS 
Worldwide contains no scripts but may be altered using scripts from the Available Script Files list 
(see Add to Menu, below). 

New Menu 
Click this button to create (name) a new menu.  Note: Whatever menu is selected from 
the drop-down list box will be, optionally, the basis of the new scheme. 

Rename Menu 
Click this button to rename a selected menu. 

Delete Menu 
Click this button to delete a selected menu. 

Add to Menu 
After selecting a script from the Available Script Files list, press this button to initiate the 
Script Menu Caption dialog and add a text string that comprises the menu selection. 

An access key may be designated by placing an ampersand (&) in front of a single character of 
the text string.  Example:  "&Sign-On" would appear as "Sign-On" on the menu implying the 
"S" would serve as the access key. 

Change Script 
Click this button to change the script currently assigned to the selected item in the Script Menu 
Entries list to the script file selected in the Available Script Files list. 

Edit Caption 
Press this button to edit the caption of the selected script in the Script Menu Entries list box. 

Remove Menu 
Click this button to remove the selected menu item in the Script Menu Entries list box from the 
Scripts menu. 

Move Up (up arrow) 
Use this button to move the selected script in the Script Menu Entries list box up one entry on 
the Script menu. 

Move Down (down arrow) 
Use this button to move the selected script in the Script Menu Entries list box down one entry 
on the Scripts menu. 

Import 
Click this button to import an existing script control file. 

Export 
Click this button to export the current script configuration to a file.  In this manner, you may 
configure a script menu on one PC for distribution to other PCs. 

Change Script Folder 

Click this button to change the directory where script files (.BAS and .BAX) may be found/stored. 

Custom Keyboard 

Press this button to initiate the eXpress Custom Keyboard Layouts dialog where activation key(s) may be 
assigned to scripts. 

OK 

Press this button to accept the entries on this dialog and continue. 
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Cancel 

Press this button to cancel any entries made on this dialog. 

 

eXpress Custom Terminal Screen Appearance 

The tab labeled Fonts and Colors, on the T27 eXpress Plus Configuration contains configuration 
controls to change screen and printer fonts and to apply colors to specific areas of the display. 

 

  

Appearance Scheme Name 

From this drop-down list box, select the Color Scheme Name to be altered.  Initially, one color scheme, 
Default, is delivered with T27 eXpress Plus.  From the Default color scheme, others may be created 
using the Save As button. 

New Scheme 

Use this button to create a new color scheme based on the T27 eXpress Plus defaults.  By this means, 
each screen can have its own color scheme or screens may share a color scheme.  To attach a color 
scheme to a screen, see T27 eXpress Plus Configuration - General tab. 

Note:  The scheme named "Default" may be changed but cannot be deleted.  When a new scheme is 
created or an existing scheme Set to Default (see below), the default values are acquired from constants 
internal to T27 eXpress Plus, not from the "Default" scheme mentioned here. 
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Rename Scheme 

Click this button to rename an existing appearance scheme. 

Delete Scheme 

Click this button to remove the selected color scheme.  Caution:  Any screen attached to the deleted color 
scheme will revert to the Default color scheme. 

Screen Color Settings 

The Screen Color Settings group contains controls that may be used to change the foreground and 
background color of various T27 screen attributes. 

Select Attribute 
From this group, select an attribute option button whose color is to be changed.  When an 
attribute’s colors are changed, those colors will be applied to all areas of the screen having that 
specific attribute.  An attribute’s colors consist of a foreground (text) color and a background 
color. 

Note: The Highlighting button, used in conjunction with the Highlighting Combinations 
options, offers a possibility of 16 color pairs (foreground/background) when selecting colors for 
highlighting attributes (Underline, Bright, Blinking and Reverse Video), a combination of those 
attributes or no attributes. 

Highlighting Combinations 
This group of checkboxes becomes visible only when the Highlighting button is selected.  Each 
checkbox represents a highlighting attribute.  After selecting an attribute, combination of 
attributes or no attribute, use the Choose Foreground (text) Color and Choose Background 
Color controls to set the colors for that selection. 

On the following screen, there are three examples of highlighting:  Highlighting-None (white on 
teal), Highlighting-Underline (white on blue) and Highlighting-Bright (yellow on teal). 
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Configuration for Highlighting-Bright: 
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Choose Foreground (text) Color 
To change the text color of an attribute, first select the attribute from the Select Color for 
Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish to 
use one of the standard Windows colors, select Custom at the bottom of the list and configure 
the desired color with the standard Windows Color dialog. 

Choose Background Color 
To change the background color of an attribute, first select the attribute from the Select Color 
for Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish 
to use one of the standard Windows colors, select Custom at the bottom of the list and configure 
the desired color with the standard Windows Color dialog. 

Screen Font 

Use the controls in this group to change the screen font, intensity, size and character set. 

Font Name 
From this drop-down list box, choose the desired font. 

Bold 
Click this button toggle to increase or decrease the intensity of the selected font. 
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Font Size 
Use this spin box to increase or decrease the size of the selected font. 

Character Set 
Use this drop-down list box to change the character set. 

Auto Scaling Mode 

These three options control how the emulator will behave when you size a station window or change the 
screen font. 

None 
When the None option is set, no screen or font scaling will be performed when the screen 
window is resized. 

Screen to Font 
The Screen to Font option causes the screen window size to be changed automatically when the 
screen font size is changed.  Consequently, the station window size may be changed without 
altering the size of the font.  If the size of the window is made larger than that necessary to 
accommodate the screen size, a blank area will show the physical limits of the screen. If the 
window size is reduced below the physical screen size, scroll bars appear allowing access to those 
parts of the screen not currently visible.   

Font to Screen 
The Font to Screen option causes the font size to change automatically whenever the window 
size of the station is altered.  For example: If a window is enlarged or made smaller, the font will 
increase or decrease in size, accordingly.  The Font to Screen option will only work when using 
a scalable font (e.g., Courier New, Lucida Sans Typewriter, etc.).  To select a scalable font, click 
on the Screen Font button. 

Default 

Use this button to change the selected color scheme to the UTS eXpress Plus defaults. 

Import 

Click this button to import an existing appearance settings file. 

Export 

Click this button to export the appearance settings to a file. 

Apply 

Apply the settings immediately without exiting the configuration window.  If you have entered the 
configuration window from the emulator, you will see any changes take effect in the emulator 
immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

eXpress Custom Keyboard Layouts 

This window is used to define which Windows keyboard key or key combination will be used to initiate a 
T27 terminal or T27 eXpress Plus emulation specific action.  Use this window to customize the keyboard to 
meet your specific needs. 
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New Keyboard 

Click this button to name a new keyboard layout. 

Rename Keyboard 

Click this button to rename an existing keyboard layout. 

Delete Keyboard 

Click this button to delete the selected keyboard layout. 

Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations associated with a terminal 
key.  Note: The location and arrangement of the keys on the graphic keyboard may not match the exact 
layout of your keyboard; however, most keys on your keyboard should have its corresponding key 
represented on the graphic keyboard.  After selecting a key name from the Key Actions and Key 
Sequence Assignment list, the configured key or key combinations will appear as if they have been 
pressed.  You may change (redefine) or add additional key combinations by pressing the key(s) on the 
graphic keyboard with a left mouse click.  Valid key combinations are any single key plus one or more of 
the optional, Shift, Alt and Ctrl keys.  When the desired key combinations have been selected, press the 
Set Assignment button to assign the key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to change 
accordingly. 

The extended keys (see below) are not mapped to any key in the Key Actions list for the default 
keyboard layout file.  They may however be mapped by the user to any key in the Key Actions list.  If 
they are not mapped, their behavior will be the same as their counterparts on the numeric keypad and 
main keyboard. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 
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Key Actions 

This list box contains the names of all keys used to control T27 terminal activities or activities specific to a 
developed application.  These keys can be mapped to keys pressed on the graphic keyboard or via the 
Type a Key Sequence button. 

Type a Key Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type the 
key sequence you desire to map to the currently selected name in the Key Action list.  On your 
acceptance of the typed key sequence, the key will automatically be mapped. 

Set Key Assignment 

This button sets the mapping of the currently selected Key Actions to the selected graphic keyboard 
keys. 

Undefine Key 

This button is used to remove the mapping of the key.  You may remove a mapped key by first selecting 
the key in the Key Actions list followed by a click of this button. 

Default 

This button loads the default keyboard layout as distributed by KMSYS Worldwide, Inc. 

Import 

Use this button to import an existing keyboard definition file (.KEY). 

Export 

Use this button to save the current keyboard layout to a file. 

Print 

Click this button to print a list of all key actions and key action assignments.  Note: The list will include 
any key sequences assigned to scripts. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

How to Map or Re-Map a Key Action 

The following describes the procedure for re-mapping T27 terminal or T27 eXpress Plus keys: 

1. Select the key to be re-mapped from the Key Actions list box. 

2. There are two methods of defining which key or key combination to map to the selected name in 
the Terminal Keyboard Key Names list: 

a. Click the Type Key Sequence button, then type the desired key sequence directly on your 
keyboard.  When you accept the key sequence, the key mapping will automatically be set. 

b. Select the desired key from the graphic keyboard using a left mouse click over the face of 
the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them with the 
mouse.  Finally, to set the keys selected, click the Set Key Assignment button. 

These steps may be repeated until all desired key mappings are completed. 

Conflicts 

If a selected key sequence is already mapped to another key, a message box will appear naming the 
mapped Key Action.  You may then re-map or "undefine" the Key Action in conflict or choose a different 
key sequence. 

If you map a Key Action that already has a key sequence assigned to it, a window will appear allowing you 
to Add an alternate key sequence, Redefine (replace) the existing key sequence with the new key 
sequence or Cancel the key assignment operation altogether. 

Add or Redefine Key 

The Add or Redefine Key window appears when a conflict is discovered while attempting to assign a 
keystroke or keystroke combination to a keyboard function. 

Help 

Click this button to receive on help for this window. 
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Add 

Click this button to add an alternate key sequence.  This choice is useful when you want more than one 
keyboard key to perform the same function (e.g., the two Enter keys). 

Redefine 

Redefine or replace the existing key sequence. 

Cancel 

Clicking the Cancel button closes this window without assigning the key. 

T27 eXpress Custom Toolbar Design 

The T27 eXpress Custom Toolbar Design window provides the means to design and maintain 
customized toolbars for screens.  Toolbars may contain buttons for any T27 Key or previously developed 
T27 eXpress Plus Script. 

 

  

File menu 

New 
Select this item to initiate a new toolbar. 

Open 
Select this item to open an existing toolbar file (.TBR). 

Open Default Toolbar 
Select this item to open the default toolbar as supplied by KMSYS Worldwide, Inc.  Note:  This 
toolbar may not be altered but may be used as the basis of user-defined toolbars (see Save As, 
below). 
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Save 
Select this item to save changes to the current toolbar file.  This item is only enabled after a 
change has been made. 

Save As 
Select this item to save changes made to the current toolbar to a different file. 

Change Toolbar Directory 
Select this item to open the standard Select Directory dialog.  This selection allows you to change 
the toolbar directory from the default installation directory to any desirable location. 

Close 
Select this item to close the T27 eXpress Custom Toolbar Design window.  If changes have 
been made, a conformation message box will appear allowing you to save or discard any 
changes. 

Recently Accessed Toolbar Files 
Select any item from this list of the four most recently accessed toolbar files (.TBR). 

Tool Bar Button Display Area 

The area at the top of this window contains a visual representation of how the tool bar will appear when 
assigned to and displayed on an emulator screen.  You may select an existing button from either the 
visual display or the list box at the bottom of the window. 

Insert Button 

Click this button to insert a new button on the tool bar.  Note:  The new button will appear immediately 
before the button selected on the visual button bar display (or the list box). 

Remove Button 

Click this button to remove the selected button from the toolbar. 

Insert Spacer 

Click this button to insert a spacer to the left of the currently selected button.  Note: The spacer may be 
sized by first selecting the spacer on the tool bar and then using the Button Width buttons. 

Insert Line Break 

Click this button to place a line break before the currently selected button. 

Move 

Use these buttons to move the selected button to the right or left along the toolbar.  If the toolbar 
consists of more than one row, a selected button on the first row, moved repeatedly to the right, will 
eventually end up on the second.  The reverse is true when moving a button on a lower repeatedly to the 
left; i.e., the button will at some point move to the row above. 

Ctrl+LeftArrow 
Click this button to move the selected button one-button position to the left. 

Ctrl+RightArrow 
Click this button to move the selected button one-button position to the right. 

Button Width 

Use these buttons to decrease or increase the width of the selected button. 

Shift+LeftArrow 
Click this button to increase the width of the selected button. 

Shift+RightArrow 
Click this button to decrease the width of the selected button. 

Font Size 

Use these buttons to decrease or increase the font size of button face captions.  Changing the button face 
font size is global to all buttons on the toolbar. 

Shift+DownArrow 
Click this button to decrease the font size. 

Shift+UpArrow 
Click this button to increase the font size. 
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Button Caption 

This text box contains the caption that will appear on the button face.  If the button caption is larger than 
can be accommodated by the initial button size, use the Button Width buttons to increase (or decrease) 
the button's width. 

If the caption is a single dash (-), the button will not be visible, but will be used as a "spacing tool" to 
separate button groups.  To increase or decrease the space between buttons, select a spacing tool button 
from the configured buttons list box at the bottom of the dialog and press the Button Width buttons. 

If the caption is a single equal sign (=), the button will not be visible and will be used as a "row separator" 
to advance the toolbar to the next row. 

Load Bitmap 

Click this button to select a bitmap file (.BMP) to be used on the selected button face.  If a Button 
Caption is supplied in addition to the bitmap, the caption will appear to the right of the bitmap. 

Clear Bitmap 

Click this button to remove the bitmap from the selected button. 

Tool Tip 

This optional text box may be used to provide a tool tip for the button.  The text of the tool tip will be 
displayed in a pop-up box when the mouse cursor is moved over the toolbar button during emulation. 

Current Button Action 

This information box shows what action (T27 Key or T27 eXpress Plus Script) will be taken when the 
button is pressed during emulation. 

Assign Action 

Click this button to assign the selected action to the button.  To assign an action, first select the desired 
button from the visual button bar display (or the list box) at the bottom of the dialog.  By selecting the 
button, the button's caption, optional tool tip and existing action will be displayed in the boxes at the top 
of the dialog.  Finally, select an action from the Select Button Action drop-down list box and click the 
Assign Action button. 

Select Button Action 

This drop-down list box contains all T27 Keys and previously developed T27 eXpress Plus Scripts that may 
be assigned to a button and executed when the button is pressed during emulation. 

Close 

Use this button to close the T27 eXpress Custom Toolbar Design window.  If changes have been 
made, a conformation message box will appear allowing you to save or discard any changes. 

Character Translation Configuration 

The Character Translation Configuration window provides the ability to select and edit character 
translation sets for specific countries. 
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Select the translation set (the default is NO TRANSLATION) for your locality. 

To add a translation set, click the Add button.  A second window will appear where you may enter a 
country name that will correspond to the translation set. 

To change one or more characters in a translation set, highlight a country name using the left mouse 
button or the up/down arrow keys and click the Edit button. 

To delete a translation set, highlight a country name using the left mouse button or the up/down arrow 
keys and click the Delete button. 

Import 

Use this button to import an existing character translation file (.ini). 

Export 

Use this button to save the current character translation configuration to a file. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

 

Character Translation Edit 

This window allows you to specify host character and local character pairs for translation on all data 
received from, or sent to, the host during a T27 eXpress Plus session.  All characters are specified in 
ASCII numeric notation. 
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Select an existing character in the translation table using the scroll bar, mouse and/or up/down arrow 
keys.  Type any changes into the two text boxes (Host and Local) at the bottom of the window. 

To add a new character, select each of the two text boxes (Host and Local) at the bottom of the window, 
enter the new values and click the Add button. 

To delete an existing character, select a character in the translation table using the scroll bar, mouse 
and/or up/down arrow keys and click the Delete button. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

 

Lock Config. Initial Password 

This dialog is used to supply an initial password that will be required to access the controls for 
configuration. 

New Password 

Enter a 1-8-character password.  All keyboard characters are allowed. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 

Cancel 

Press this button to cancel any entries made on this dialog. 
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Unlock Config. Password 

This dialog is used to supply the password that will enable configuration controls.  The dialog may also be 
used to change an existing password.   

Enter Password 

Enter the password required to unlock (enable) configuration controls. 

New Password 

To change the password, enter the new password in this box.  This entry is optional. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 

Cancel 

Press this button to cancel any entries made on this dialog. 

T27 eXpress Plus Settings 

This dialog is used to switch the location of the T27 eXpress Plus configuration settings.  The settings may 
be stored in such a manner as to allow multiple users of a single Windows system to maintain their 
individual configurations.  When individual configurations are to be maintained (the default), the settings 
are placed under C:\Documents and Settings\<This User>\Application Data.  On the other hand, if it is 
desirable for all users of the system to use the same configuration, an option is available to move those 
settings to the common location, C:\Documents and Settings\All Users\Application Data. 

Note: "<This User>" will be the user-id used to log on to Windows. 

 

  

  
The dialog acts as a toggle between <This User> and All Users; i.e., if your settings are currently stored in 
<This User>, the message will indicate that they be moved to All Users; if they are in All Users, the move 
would be to <This User>. 

Move 

After selecting an option above, click this button to complete the move. 
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Cancel 

Press this button to ignore any selections and return to the previous dialog. 

Select Directory 

Use this dialog to select the default drive from the Drives drop-down list box and the default directory or 
directories from the Directories list box. 
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How to ... 
Selecting with the Mouse 

All selections discussed in this section are made with a single click of the left mouse button.  For example 
the instruction, "select Print Screen from the File menu," implies that the following actions should be 
taken: 

1. Move the mouse cursor over the word, File, on the menu bar. 

2. Click the left mouse button once to reveal the menu. 

3. Move the mouse cursor over the Print Screen selection. 

4. Press the left mouse button again to complete the instruction. 

Note: Left and right, mouse button actions may be reversed (run the Mouse icon/program in the Windows 
Control Panel). 

Many of the menu selections also have corresponding buttons.  These buttons are conveniently located on 
a toolbar immediately below the menu bar.  These buttons represent the more frequently executed T27 
eXpress Plus commands or selections. 

Where appropriate, shortcut keys are shown in parentheses and toolbar buttons are shown in the right 
margin of the discussions below. 

Tracing T27 eXpress Plus Host Sign-On Activity 

If you are having difficulty connecting to the host, three "Command Line" options are available to collect 
a trace of the sign-on activity: 

The tw option (e.g., c:\Program Files\KMSystems\T27Plus32\3.0\T27Plus32.exe" tw) will open a 
separate trace window where the host connection activity may be viewed. 

The tf option will gather the activity to a file.  Note:  You will be prompted to enter the file name. 

The tb option will trace the activity to both the trace window and the file. 

Add the option to the Target entry of the T27 eXpress Plus shortcut as follows: 

1. Right click on the T27 eXpress Plus icon.  From the Windows Task Bar, this icon is on the 
Start | Programs | T27 eXpress Plus menu.  For T27 eXpress Net, the icon may be on 
the desktop.  

2. Select Properties. 

3. Change the Target entry. 

Running without the Control Panel 

You may run T27 eXpress Plus without the control panel being visible using the NCP command line option 
as follows: 

"c:\Program Files\KMSystems\T27Plus32\3.0\T27Plus32.exe" NCP 

Note: The NCP option may not be set if you are running the network version of T27 eXpress Plus, T27 
eXpress Net; however, the person responsible for maintaining T27 eXpress Net may configure your user 
id. to hide the control panel with an option in the T27 eXpress Net Administrator program. 

To run with the NCP option, you must first run without it and configure at least one environment to 
automatically open at start-up.  To configure: 

1. Start T27 eXpress Plus without the NCP option. 

2. Click the Configure T27 eXpress Plus Options button on the control panel. 

3. Select and configure an environment as desired. 

4. Check the Open this Environment on Start-up 

5. Repeat Steps 3 and 4 if additional environments are required. 

6. Click the OK button. 

7. Click the Exit button on the control panel. 

Finally, add the NCP command line option to the Target entry of the T27 eXpress Plus shortcut as 
follows: 

1. Right click on the T27 eXpress Plus icon.  From the Windows Task Bar, this icon is on the 
Start | Programs | T27 eXpress Plus menu.  For T27 eXpress Net, the icon may be on 
the desktop.  

2. Select Properties. 

KMSYS Worldwide, Inc. 35 



How to ... T27 eXpress Plus Help 

3. Change the Target entry. 

Note: When all environments are closed by the user, T27 eXpress Plus will automatically exit. 

Configuring T27 Keys 

To change a T27 key, follow this procedure: 

1. Click on the Configure T27 eXpress Plus button on the T27 eXpress Plus Control Panel.  

2. After selecting a screen tab, press the Custom Keyboards button on the Appearance and 
Keyboard tab.  The eXpress Custom Keyboard Layouts window will appear. 

3. Select the keyboard layout you wish to configure from the Keyboard Name drop-down list 
box, or a new layout using the New Keyboard button to the right.  Note: Layouts are related 
via a named keyboard and associated with a particular screen on the Appearance and 
Keyboard tab.  In this manner, it is possible for each configured screen to have its own 
unique keyboard layout or share a layout with other screens. 

4. Select a key from the list box under Terminal Keys. 

5. Press the desired key or key combination (any key plus Alt, Ctrl and/or Shift) on the visual 
keyboard. 

6. Press the Set key assignment button. 

7. If a key is already defined, a message window will appear allowing you to replace (Redefine) 
the existing definition or Add an additional definition.  Also, if a key combination is already 
assigned to another key action, you will get an error.  In that case you will need to 
"Undefine" that other key action first. 

8. Press the OK button on the eXpress Custom Keyboard Layouts window. 

9. Back on the Appearance and Keyboard tab, select your keyboard from the Select Custom 
Keyboard Layout drop-down list box.  Note: You may have to exit the Configuration window 
and re-enter to see the name of your keyboard in the list box. 

10. Repeat steps 2 through 8 for each screen desired. 

11. Press the OK button on the T27 eXpress IT Configuration window. 

Creating a Toolbar Button to Run a Script 

After developing and saving a script with the Script Editor, the script is saved with a .BAS extension, and 
optionally as a compiled file (.BAX), in the SCRIPTS directory.  This script is then available to be placed on 
a screen’s Script menu (see the T27 eXpress Plus Script Manager) and/or on a toolbar.  The following 
procedure illustrates the steps required to associate a script with a toolbar button: 

1. Click the Configure T27 eXpress Plus button on the T27 eXpress Control Panel.  

2. After selecting a screen tab, press the Custom Tool Bars button on the Appearance and 
Keyboard tab.  The T27 eXpress Custom Toolbar Design window will appear.  Note: If you 
wish to create your own tool bar by adding to the default tool bar, select Open Default Tool 
Bar from the File menu.  After making changes, you may do a Save As from the File menu.  
Note: Tool bars are related via a tool bar file and associated with a particular screen on the 
Appearance and Keyboard tab.  In this manner, it is possible for each configured screen to 
have its own unique tool bar or share a tool bar with other screens. 

3. Note: A blank button is present at the top of the window in the area titled, Tool Bar Preview 
Area. 

4. With this "blank" button selected, type the word(s) for the button face in the Button Caption 
text box. 

5. If the text entered will not fit on the button face, increase the button width or decrease the 
font size.  

6. From the Select Action drop-down list box, choose the desired script (Note: They are all the 
way down, at the bottom of the list box). 

7. Click the Assign Action button.  Now, when the button is pressed on the screen’s tool bar, 
the script will be executed. 

8. To move the button to another part of the tool bar, use the move arrows.  

9. Press the Close button on the UTS eXpress Custom Tool Bar Design window. 

10. Click the Select button to the left of the Custom Tool Bars button to attach any custom tool 
bar to the selected screen. 

11. Repeat 2 through 10 for each screen desired. 

12. Press the Close button on the T27 eXpress Custom Toolbar Design window. 
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13. Press the OK button on the T27 eXpress Plus Configuration window. 

Applying Colors and Fonts to a Specific Environment 

You may change the appearance of the text displayed on the T27 eXpress Plus environment by selecting 
from a list of screen fonts installed on your system.  Colors may be applied based on field attributes 
displayed in the environment.  To change the screen’s font and or color, follow this procedure: 

1. Click the Configure T27 eXpress Plus button  on the T27 eXpress Plus Control Panel.  

2. After selecting a screen tab, click the Custom Appearance button  on the Appearance and 
Keyboard tab. 

3. Select a scheme name from the Appearance Scheme Name drop-down list box or press the 
New Scheme button and name a new scheme.  Note: Colors and fonts are related via a 
scheme name and associated with a particular screen on the Appearance and Keyboard 
tab.  In this manner, it is possible for each configured screen to have its own unique font and 
color scheme or share a scheme with other screens. 

4. Select the desired font and font sty with the controls at the bottom of the window in the 
Screen Font group. 

5. For color changes, select a field attribute from the option buttons in the Select Color for 
Attribute option group. 

6. Next, select the foreground (text) and background colors from the two drop-down list boxes 
provided. 

7. Repeat Steps 5 and 6 for each attribute required by your host application. 

8. When done, click the OK button. 

9. From the Select Screen Appearance Scheme drop-down list box, select the custom 
appearance scheme. 

10. Repeat Steps 2 through 9 for each screen desired. 

11. Press the OK button on the T27 eXpress Plus Configuration window. 

Recall Recent Input 

On occasion, you may wish recall or retransmit a line of input to the host, and that line no longer appears 
on the screen.  T27 eXpress Plus retains a list of the 200 most recent lines sent to the host when not in 
forms mode.  The following procedure outlines the steps required to use this feature: 

1. Position the cursor at the point on the screen where you wish the line to be repainted. 

2. Press Ctrl+Up Arrow (this key is configurable, see Configuring T27 Keys) or select Input 
Recall from the Edit window. 

3. With the mouse, select the desired line from the list box provided. 

4. Click the Transmit button to paint the line and transmit it to the host (double-clicking the line 
will also cause a transmit).  If you wish to alter the line before transmitting, click on the Paste 
button. 

Note:  This feature is particularly useful when the recall line is lengthy and you wish to avoid having to 
retype the entire line. 

Displaying T27 eXpress Plus Keyboard Definitions 

At times, you may wish to perform standard T27 terminal functions through the keyboard such as ERASE 
TO END FIELD, TAB BACK, etc.  An easy way to see the keyboard key sequences required to perform 
these T27 terminal functions is through the display of the Keyboard Help window.  To view this window, 
select Show Keyboard Help Window from the View menu. 

Double click on any entry (T27 key or Keyboard Key Sequence) in the window’s list box to execute the 
T27 function, or leave the window displayed as a reference to key sequences required from the keyboard.   

With the Keyboard Window displayed, you may reposition the cursor with a single left mouse click 
anywhere in a T27 eXpress Plus screen. 

To keep the Keyboard Help window completely visible while working on a T27 eXpress Plus screen, check 
the Stay on top box. 
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Miscellaneous 
Command Line Options 

The following are the T27 command line options.  They are NOT case sensitive and are separated by 
spaces: 

NL  = No Logo (Splash Screen) 

NCP = No Control Panel 

SMAX = Show Screens Maximized 

TRANSTRACE = Transport Trace On Start   

MULTI_INST = Allow multiple instances of program 

Note: The NCP option may not be set if you are running the network version of T27 eXpress Plus, T27 
eXpress Net; however, the person responsible for maintaining T27 eXpress Net may configure your user 
id. to hide the control panel with an option in the T27 eXpress Net Administrator program. 

Font Limitations 

The ability to increase/decrease font size by a single point only works properly when using scalable fonts 
like the True Type font, Courier New (installed with Windows).  Non-scalable fonts have a fixed number of 
point sizes available (e.g., 6, 9, 11, 14, etc.) and are missing several point sizes (e.g., 7, 8, 10, 12, 13).  
Consequently, T27 eXpress Plus will be unable to increment/decrement to the missing sizes.  To select a 
different font, follow this procedure: 

1. Click on the Configure T27 eXpress Plus button  on the T27 eXpress Plus Control Panel.  

2. Select the desired screen tab. 

3. Select the Appearance and Keyboard tab. 

4. Select the desired font and font style. 

5. Press the OK button. 

Note: All of the True Type fonts are scalable. 

Technical Support 

If you are experiencing difficulties configuring T27 eXpress Plus and need assistance, please contact the 
person responsible for maintaining T27 eXpress Plus at your site.  If you are having trouble connecting to 
a host mainframe, please consult the person(s) responsible for maintaining communications at your site.  
If difficulties persist, you may reach the Technical Support Group at KMSYS Worldwide, Inc., through one 
of the following: 

 

Internet E-mail Support – support@kmsys.com 
Telephone Support – (770) 635-6363  
Web Site – www.kmsys.com 
Main Number – (770) 635-6350 
Facsimile – (770) 635-6351 
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